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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below:

• The below Displays are no longer sold nor maintained by Pro-face. To reduce 
unplanned downtime due to aged hardware and to maximize your cyber security 
environment we recommend replacing your devices with a new, successor model.
For details, please visit our homepage for "Recommended Substitution".
Discontinued from GP-Pro EX 5.00 onwards: GP3000 Series, LT3000 Series, 
ST3000 Series, GP-4100 Series (Monochrome model), PL Series, PS3000/4000 
Series, PE4000 Series.

• For details on the Displays supported by the driver, please check the "Connectable 
Devices" on our website.
http://www.pro-face.com/trans/en/manual/1064.html

1 System Configuration
This section lists the types of External 
Devices and SIO that you can connect.

"1 System Configuration" (page 3)

2 External Device Selection
Select a model (series) of the External 
Device and its connection method.

"2 External Device Selection" (page 6)

Operation

3 Communication Settings
This section shows setting examples for 
communicating between the Display and 
the External Device.

"3 Communication Settings" (page 8)

4 Setup Items
This section describes communication 
setup items on the Display. Set the 
Display’s communication settings in GP 
Pro-EX or in off-line mode.

"4 Setup Items" (page 20)

http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
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1 System Configuration

The system configuration for the Display connected to the CoDeSys Automation Alliance External Device is 

shown below.

 Connection Configuration
• 1:1 Connection

Series CPU Link I/F
Communication 

Method
Setting Example

3S-Smart Software Solutions 
GmbH

CODESYS Control Win V3
PC/AT Ethernet Interface Ethernet (TCP) "Setting Example 1" 

(page 8)

Hitachi Industrial Equipment 
Systems Co., Ltd.

EHV+

1006
1025
1051
1102

Ethernet Interface Ethernet (TCP) "Setting Example 1" 
(page 8)

Hitachi Industrial Equipment 
Systems Co., Ltd.

HX

HX-CP1S08
HX-CP1H16

HX-CP1S08M
HX-CP1H16M
HXC-CP1H16

Ethernet Interface Ethernet (TCP) "Setting Example 2" 
(page 11)

Lenze Vertrieb GmbH 
Controller 3200C 3200C Ethernet Interface Ethernet (TCP) "Setting Example 1" 

(page 8)

Schneider Electric SA 
Modicon

M241
M251 Ethernet Interface Ethernet (TCP) "Setting Example 3" 

(page 14)

M262 Ethernet Interface Ethernet (TCP) "Setting Example 4" 
(page 17)

• Please refer to the latest list of the External Device to be supported by this driver on the Pro-
face’s website.
http://www.pro-face.com/product/soft/gpproex/driver/driver.html

• This driver does not support GP3000 Series, LT3000 Series, GP-4100 Series (Monochrome 
Model), GP-4*01TM and GP-Rear Module.
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• 1:n Connection

• 1:n Connection (Gateway connection)

• n:1 Connection

* The number of Displays you can connect depends on the External Device. Check the specifications of the 

External Device.
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• n:m Connection

* The number of Displays you can connect depends on the External Device. Check the specifications of the 

External Device.
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2 External Device Selection

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/PLCs

Use an integer from 1 to 2 to enter the number of Devices/PLCs to connect to the 
display.

• When you set up the CoDeSys Automation Alliance CoDeSys V3 Ethernet driver, 
the number of drivers that can connect simultaneously is as follows. 
• Models that can connect up to 4 drivers: 2
  (CoDeSys V3 Ethernet and one other driver)
• Models that can connect up to 2 drivers: 1
  (CoDeSys V3 Ethernet only)

Manufacturer Select the manufacturer of the External Device to be connected. Select "CoDeSys 
Automation Alliance".

Series

Select a model (series) of the External Device to be connected and connection 
method. Select "CoDeSys V3 Ethernet".
Check the External Device which can be connected in "CoDeSys V3 Ethernet" in 
system configuration.

"1 System Configuration" (page 3)

Port Select the Display port to be connected to the External Device. Select [Ethernet 
(TCP)].
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Use System Area

Check this option to synchronize the system data area of the Display and the device 
(memory) of the External Device. When synchronized, you can use the External 
Device’s ladder program to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method 
Area)"

This feature can also be set in GP-Pro EX or in the Display's offline mode.
Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - 

[System Area] Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area 

Settings"

Setup Items Setup Description
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3 Communication Settings

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP 
address and port number.

• While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open 
Box and the gateway restarts, communication may not be restored. If that happens, restart the 
display unit.

• Use the programming software for the External Device to check the gateway's node name, 
node address and IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address in 
the same network.

• Set up the External Device's IP address and Port Number in the [Individual Device Settings] 
dialog box.

• Set up the Display's IP address in offline mode.
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 Settings of External Device
Use the programming software for the External Device to define its communication settings. Please refer to the 

manual of the External Device for more details.

1 In the programming software, create a project.

2 Select [Device] from the [Devices] tree view.

3 Click [Scan network] and search for the External Device to use.

4 Select the added External Device, and confirm the [Node Name] or [Node Address].

• When searching for External Devices, the External Device and host must exist on the same 
network. Please refer to the manual of the External Device for more details.

• When using a gateway, check the gateway's IP address and port number.
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP 
address and port number.

• While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open 
Box and the gateway restarts, communication may not be restored. If that happens, restart the 
display unit.

• Use the programming software for the External Device to check the gateway's node name, 
node address and IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address in 
the same network.

• Set up the External Device's IP address and Port Number in the [Individual Device Settings] 
dialog box.

• Set up the Display's IP address in offline mode.
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 Settings of External Device
Use the programming software for the External Device to define its communication settings. Please refer to the 

manual of the External Device for more details.

1 Create a project in the programming software.

2 From the [Devices] tree view double-click [Device].

3 Click [Scan network] to find the External Device.

4 Select the External Device, and click [OK].

5 Click [PLC Parameters] and set up the communication port as follows.

6 From the [Online] menu select [Login], and log in to the External Device.

7 Download the project and restart the External Device.

• To search for External Devices, the External Device must be on the same network as the host. 
For information, refer to the manual of the External Device.

Setup Items Setup Description

IP Address 192.168.0.1

Subnet Mask 255.255.255.0

Change IP information Yes

• ETH1, ETH2, and ETH3 cannot be set to the same network.
• When changing the IP address, set [Change IP information] to [Yes].
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3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP 
address and port number.

• While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open 
Box and the gateway restarts, communication may not be restored. If that happens, restart the 
display unit.

• Use the programming software for the External Device to check the gateway's node name, 
node address and IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address in 
the same network.

• In the [Node Name (or) Address] field, set the device name of the External Device. You 
cannot use the IP address for communication.

• Set up the Display's IP address in offline mode.
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 Settings of External Device
Use the programming software for the External Device to define its communication settings. Please refer to the 

manual of the External Device for more details.

1 In the programming software, create a project.

2 From the [View] menu, select [Navigators]-[Devices tree].

3 From the [Devices tree], double-click the [MyController].

4 Click [Controller selection].

5 Right-click the External Device, and select [Change device name].

6 Input the [Device name].

7 Click [OK].

• The setting of Device name have to be identical to that of GP-Pro EX.

• When communicating with GP-Pro EX, set the Device name for the External Device. IP 
addresses cannot be used for communication.
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the External Device and click [Settings] . To connect multiple External Devices, from 

[Device-Specific Settings] in the [Device/PLC] window, click [Add Device] to add another External Device.

• When using a gateway, select the [Connect via Gateway] check box and set the gateway's IP 
address and port number.

• While using a display unit other than IPC, PC/AT compatible machine, or SP5000 Series Open 
Box and the gateway restarts, communication may not be restored. If that happens, restart the 
display unit.

• Use the programming software for the External Device to check the gateway's node name, 
node address and IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address in 
the same network.

• Set up the External Device's IP address and Port Number in the [Individual Device Settings] 
dialog box.

• Set up the Display's IP address in offline mode.
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 Settings of External Device
Use the programming software for the External Device to define its communication settings. Please refer to the 

manual of the External Device for more details.

1 In the programming software, create a project.

2 From the [View] menu, select [Navigators]-[Devices tree].

3 From the [Devices tree], double-click the [MyController].

4 Click [Controller selection].

5 Right-click the External Device, and select [Change device name].

6 Input the [Device name].

7 Click [OK].

• The setting of Device name have to be identical to that of GP-Pro EX.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Communication Settings" (page 8)

4.1 Setup Items in GP-Pro EX

 Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in off-line mode.

Cf. Maintenance/Troubleshooting Guide "Ethernet Settings"

Setup Items Setup Description

Port No. Displays the port number of the Display, from 1024 to 65535.
The port number is set automatically.

Timeout Time (in seconds) that the Display waits for a response from the External Device, from 1 to 
127.

Retry Number of times, from 0 to 255, the Display will re-transmit a command when it does not 
receive a response from the External Device.

Wait To Send Amount of time, from 0 to 255 milliseconds, the Display waits after receiving a 
communication packet before transmitting the next command.

• Refer to the GP-Pro EX Reference Manual for information on Indirect Devices.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Setup Items Setup Description

Node Name (or) 
Address

Enter the node name or node address of the connected External Device. When you enter the 
node name or node number, settings such as the IP address become unnecessary.

Use Tcp/Ip Select this check box to specify the External Device's IP address and port number.

IP Address

Set the External Device's IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Port No. Enter the External Device's port number.

Use User 
Management Select this check box when the connected External Device performs user management.

User Enter the user name.

Password Enter the password.
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Connect via Gateway When using a gateway, select this check box.

IP Address

Set the gateway's IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP address.

Port No. Enter the gateway's port number.

Use Tag Data
Select this check box.
Click [New], and import the tag data to use.

"  Importing Tag File" (page 29)

Double Word word 
order

Select the data storage order of word units for 32-bit data.
When most significant word is first: High word first (H/L)
When least significant word is first: Low word first (L/H)

Variable list registra-
tion optimization

When saving a variable list for the purpose of communication optimization, select this 
check box.

• As there is a limit to the number of variable lists that can be saved, enable only for 
External Devices that require communication optimization.

Setup Items Setup Description
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4.2 Setup Items in Offline Mode

 Communication Settings
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Please refer to Maintenance/Troubleshooting Guide for more information on how to enter 
offline mode or about operation.
Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 
Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No. Displays the port number of the Display, from 1024 to 65535.
The port number is set automatically.

Timeout Time (in seconds) that the Display waits for a response from the External Device, from 1 to 
127.

Retry Number of times, from 0 to 255, the Display will re-transmit a command when it does not 
receive a response from the External Device.

Wait To Send Amount of time, from 0 to 255 milliseconds, the Display waits after receiving a 
communication packet before transmitting the next command.
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 Device Setting
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

Setup Items Setup Description

Device/PLC Name Select the External Device to set up. The device name is the name of the External Device 
defined in GP-Pro EX. The initial value is [PLC1].

Node Address Displays the node name or node address of the connected External Device. 

TCP Connection Select [Enable] to specify the External Device's IP address and port number.
When you select [Disable], the [IP Address (Tcp)] and [Tcp Port] properties are disabled.

IP Address(Tcp)

Set the External Device's IP Address.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Tcp Port Enter the External Device's port number.

UserManagement
Select [Enable] when the connected External Device performs user management. Use the 
user name and password set in GP-Pro EX.

"  Device Setting" (page 21)

Gateway When using a gateway, select [Enable].
When you select [Disable], the [Gateway IP] and [Gateway Port] properties are disabled.

Gateway IP

Set the gateway's IP address.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Gateway Port Enter the gateway's port number.



CoDeSys V3 Ethernet Driver

GP-Pro EX Device/PLC Connection Manual 25

Double Word word 
order

Display the data storage order of word units for 32-bit data.
When most significant word is first: High word first (H/L)
When least significant word is first: Low word first (L/H)

Var. list optimization

When saving a variable list for the purpose of communication optimization, select [Enable].

• As there is a limit to the number of variable lists that can be saved, enable only for 
External Devices that require communication optimization.

Setup Items Setup Description
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5 Supported Devices

Range of supported device addresses is shown in the table below. Please note that the actual supported range of 

devices varies on the External Device in use. Please check the actual range in the manual for your connected 

equipment.

You can import tag data from the project created by your programming software.

This address can be specified as system data area.

Device Bit Address Word Address 32 bit Notes

BOOL

Single <TAGNAME> -

- *1

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGMNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

BYTE
SINT
USINT

Single <TAGNAME>.00 - 
<TAGNAME>.07 <TAGNAME>

*1*2
1D Array <TAGNAME>[xl].00 - 

<TAGNAME>[xh].07
<TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl].00 - 
<TAGNAME>[xh,yh].07

<TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl].00 - 
<TAGNAME>[xh,yh,zh].07

<TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

INT
UINT
WORD

Single <TAGNAME>.00 - 
<TAGNAME>.15 <TAGNAME>

*1*2*3
1D Array <TAGNAME>[xl].00 - 

<TAGNAME>[xh].15
<TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl].00 - 
<TAGNAME>[xh,yh].15

<TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl].00 - 
<TAGNAME>[xh,yh,zh].15

<TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

DINT
UDINT
DWORD

Single <TAGNAME>.00 - 
<TAGNAME>.31 <TAGNAME>

*1*2
1D Array <TAGNAME>[xl].00 - 

<TAGNAME>[xh].31
<TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl].00 - 
<TAGNAME>[xh,yh].31

<TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl].00 - 
<TAGNAME>[xh,yh,zh].31

<TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]
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DATE
REAL
TIME
TOD

TIME_OF_
DAY

Single

-

<TAGNAME>

*1*2

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

DATE_AND
_TIME
DT

Single

-

<TAGNAME>

- *1*4

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

STRING

Single

-

<TAGNAME>

- *1

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

LINT
LWORD
ULINT

Single <TAGNAME>.00 - 
<TAGNAME>.63 <TAGNAME>

- *5
1D Array <TAGNAME>[xl].00 - 

<TAGNAME>[xh].63
<TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl].00 - 
<TAGNAME>[xh,yh].63

<TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl].00 - 
<TAGNAME>[xh,yh,zh].63

<TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

LREAL

Single

-

<TAGNAME>

- *5

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

LTIME

Single

-

<TAGNAME>

- *5

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

Device Bit Address Word Address 32 bit Notes
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WSTRING

Single

-

<TAGNAME>

- *6

1D Array <TAGNAME>[xl] - 
<TAGNAME>[xh]

2D Array <TAGNAME>[xl,yl] - 
<TAGNAME>[xh,yh]

3D Array <TAGNAME>[xl,yl,zl] - 
<TAGNAME>[xh,yh,zh]

*1 <TAGNAME>: When referring to structures, the TagName includes the structure name. The maximum
number of characters for the Tag Name is 255, which includes delimiters and elements.
Example)

BOOL type single symbol "BOOLSYMBOL"
BOOL type 1D Array "BOOL1D[10]
WORD type 2D Array "WORD2D[10,10]
UDINT type 3D Array "UDINT3D[0,1,2]
STRING in User Defined Structure [STRUCT001] "STRUCT001.STRINGSYM"

*2 Set the data storage order of word units for 32-bit data in the Device Setting dialog box.

*3 Initially, 16 words of items are selected for the system data area. When selecting less than 16 words, set
up a tag array with more than 16 words, allocate it to the system data area, and select the items.

*4 64-bit data type on the Display, 32-bit data type on the External Device.

*5 64-bit data type on the External Device, 32-bit data type on the Display. (The Display uses just the
bottom 4 bytes and the top 4 bytes are ignored.)
When a bit is specified, normal writing cannot be performed for 31-bit to 63-bit.

*6 Tag data can be imported. Do not use it, however, since it is the data type which is not supported by the
Display.

• When connecting with EHV+ Series, arrays cannot be used for the Display.

• Sub-Scope is shown on the Display as 'Scope'$'Sub-Scope'. ('$' is delimiter)
• When importing ENUM data types, the member name is converted to ENUM0. The value “0” 

is assigned to ENUM0.
• Naming rules for the Tag Name, Data type name and Scope name are as follows:

• Special characters are not allowed.
• Consecutive underscore '_' are not allowed.
• You cannot start names with any of the following text:
  LS, USR, SCR, PRT 
• Maximum 255 characters.

• Imported BIT type variables are converted to BOOL devices. To import BIT type variables, 
you need to output a symbol file from the configuration software for CoDeSys Runtime 
version 3.5 SP6 or later.

• Please refer to the GP-Pro EX Reference Manual on the system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"

• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

Device Bit Address Word Address 32 bit Notes



CoDeSys V3 Ethernet Driver

GP-Pro EX Device/PLC Connection Manual 29

 Importing Tag File

3S-Smart Software Solutions, Lenze Vertrieb, Hitachi Industrial Equipment Systems EHV+ Series

1 Use the programming software to create symbols.

2 In the [Devices] tree view, right-click [Application].

3 From the menu select [Add Object]-[Symbol configuration].

4 Move symbols you want to use on the Display to the [Selected variables] area.

5 Build the project and download to the External Device. Symbol data (xml file) is created when downloading.

6 In GP-Pro EX, display the [Individual Device Settings] dialog box and select the [Use Tag Data] check box.



CoDeSys V3 Ethernet Driver

GP-Pro EX Device/PLC Connection Manual 30

7 Click [New] to display the [Tag List] window.

8 Click [Import]. 
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9 From [Select File] click [Browse..], and select the symbol data (xml file).

10 Select the symbols you want to import, and click [OK].

• Please refer to "Using Device/PLC Tags" of  the GP-Pro EX Reference Manual for the importing 
tag.

• If the tag data has been changed using the tool of the External Device, please import the xml file 
again.
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Hitachi Industrial Equipment Systems HX Series

1 In the programming software, create symbols in PLC__PRG.

2 From the [Devices] tree view, right-click [Application].

3 From the menu select [Add Object]-[Symbol configuration].

4 Select the check box of symbols that will be used on the display unit.

5 Build the project and download to the External Device. A symbol data file (xml file) is created at download.

6 In GP-Pro EX, from the [Individual Device Settings] dialog box, select the [Use tag data] check box.
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7 Click [New] to display the [Tag List] window.

8 Click [Import]. 
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9 From [Select File] click [Browse..], and select the symbol data (xml file).

10 Select the symbols you want to import, and click [OK].

• Please refer to "Using Device/PLC Tags" of  the GP-Pro EX Reference Manual for the importing 
tag.

• If the tag data has been changed using the tool of the External Device, please import the xml file 
again.
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Schneider Electric SA

1 In the configuration tool, create a symbol.

2 Build the project. On build, symbol data (xml file) is generated.

3 In GP-Pro EX, display the [Individual Device Settings] dialog box and select the [Use Tag Data] check box.



CoDeSys V3 Ethernet Driver

GP-Pro EX Device/PLC Connection Manual 36

4 Click [New] to display the [Tag List] window.

5 Click [Import]. 
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6 From [Select File] click [Browse..], and select the symbol data (xml file).

7 Select the symbols you want to import, and click [OK].

• Please refer to "Using Device/PLC Tags" of  the GP-Pro EX Reference Manual for the importing 
tag.

• If the tag data has been changed using the tool of the External Device, please import the xml file 
again.
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6 Device Code and Address Code

Device code and address code cannot be used.
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

 Error Messages Unique to External Device

Item Description

No. Error No.

Device Name Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.
• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.

Message ID Error Message Description

RHxx128 (Node Name): Connection open error
(Node: %s)

This message appears when the Display cannot 
communicate with the External Device, or when 
communication is interrupted.
Check the External Device settings.
(This message appears when using the node 
address or the node name for communication 
with the External Device.)

RHxx129
(Node Name): %s:Symbol mismatch with 
Device/PLC. Please update TagData in 
the project.

This message appears when accessing a symbol 
that does not exist.
Make sure the tag data matches the symbol file.

RHxx130 (Node Name): %s:Out of range value in 
write request (Address:%s)

This message appears when writing an out of 
range value.
Check the write values.
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